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Introduction to Computing 
 
Introduction 
 
This section of the course PX512 is intended to serve as an introduction to computing.  In it, 
you should acquire and develop some of the computer skills that will help you throughout 
your studies here at University and beyond into your future career.  We hope you will find 
these notes worth keeping as a reference. 
 
Because first year students have a wide range of backgrounds and are reading a variety of 
different subjects, it is impossible to design a skills course that will suit everyone.  The more 
computer literate will find this a relatively easy part of the course.  Don’t miss out doing it, 
though, for you must pass the continuous assessment part of PX1512 in order to pass the 
whole course.  Some will find this course quite hard work and have to learn a great deal in 
short space of time.  We think you will find it worth it, though. 
 
If you are someone with very little experience of computing, let the demonstrator know so 
that he can devote a little more time to you.  It can be worrying when you find yourself in the 
position of not understanding something that everyone around you seems to be finding very 
easy. It is tempting to remain quiet and not draw attention to yourself in the hope that other 
people will not then think you stupid.  DON'T DO THIS! - Ask for help.  For the more 
experienced computer users, if you see someone struggling please help them out.  Explaining 
something to someone else will deepen your own understanding - or (as many teachers 
discover to their horror) expose the fact that there’s more to it than you might have thought! 
 
What you will be learning 
 
WORD  The UK school education system has invested in computers over the last few years 
and most UK students have some knowledge of word processing using the Microsoft package 
WORD.  This package is part of the Microsoft Office suite that is supported on all University 
central facilities (and used by most University staff here).  For this reason there will be no 
formal teaching of WORD.  However, writing a letter is one thing but producing a 
professional looking report that includes equations, tables and technical diagrams is another 
matter.  The Word section of these notes will let you revise the basic use of Word (or learn it 
if you know another word processor) and introduce more advanced features commonly used 
in scientific reports.  
 
EXCEL All science students need to be able to process data, make calculations and draw 
graphs.  Excel is a "spreadsheet program" capable of doing all of these things.  Excel is also 
completely compatible with WORD, allowing you to incorporate your results into a report 
with relative ease.  If you have taken the course ‘Tools for Science’ you’ll have found that 
this course failed to include some useful Excel skills that we have included here. 
 
ASTRONOMY EXERCISE  A web-based exercise. 
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Classes 
 
Each 2-hour class will be in the form of a self-study practical lab with a demonstrator on hand 
to answer questions if you are stuck. You are expected to work through these notes and hand 
in at the end of the class the work requested, which will be marked.  Work will not be 
accepted more than a week later without a good reason. 
 
Assessment 
 
The sum total of the computing assessments is worth 15% of the total mark for the course 
(and hence 60% of the continuous assessment mark).  The assignments will be weighted in 
the ratio 1:1:2 for the Word, Excel and Astronomy assignment. 
 
Attendance 
 
You should attend each class and make sure that you sign the attendance form.  We don’t 
mind if you prefer to attempt the work in your own time but if you get stuck please don’t 
expect the demonstrator to help you out if you haven’t attended the class sessions. 
 
Teachers 
 
The demonstrator this year is Ross MacPherson  
 
Schedule 
 
Lab 1 - Word - submission: 2 single page exercises, as described within the text (on page 7 
and page 13) 
Lab 2 - Excel - submission: a 2-page exercise as described on pages 14-15 
Labs 3 & 4 - Use of classroom for Astronomy exercise - submission: a single document to be 
e-mailed, as described.  
 
Print Budget 
 
These classes require you to print a total of 4 pages for handing in. That shouldn’t stretch 
anyone’s print budget but please make sure your budget isn’t empty. 
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Preparing a document with Word 
 
Keyboard Skills 
 
Many people get by using just two forefingers for typing.  Time invested in teaching yourself 
to use all of your fingers is worth it.  In order to do this, place your fingers over the middle 
row of letters with your left hand little finger resting over A, the next finger over S and so on 
for ASDF.  Your first finger of your right hand should rest over J, the next over K and so on.  
ASDF JKL; are called your home keys.  Each finger is then used to type only the letters 
nearest to it so that your little finger on your left hand will type QAZ, your left hand fourth 
finger WSX and so on. This will be slow work at first – but you will soon get used to it and 
after a little practice you will find it much faster than just using two fingers. 
 

                                                        Q  
  A  
    Z         W  
                   S   
 E                 X      
  D  
   C 
 

                 R T 
             F G 
               V B 
 

SPACE BAR 
 
Y U 
  H J 
   N M 

                           I 
                  K 
    O               , 
         L 
            .          P 
                     :; 
                        ? 

     
Figure 1:   Home Keys 
 
 
You won’t be assessed on your typing skill in this course. 
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Introduction 
 
Word is a document preparation package that you will find very useful for writing essays and 
project reports.  If you belong to a student society, you will find some other features of Word 
very useful – for example, it is quite straightforward to prepare a newspaper, pamphlet, flier 
and so on. 
 
Word is a product of the Microsoft Corporation and is updated every few years.  On some 
versions of Word, the dialogue boxes may be slightly different from the images shown here.  
Word is almost universally available throughout the world and is without doubt the most 
popular word processing package. 
 
To open Word, login to a PC in the classroom.  There you should find the Word 2003 icon on 
the desktop.  Otherwise go to Common Applications - Microsoft Office 2003. 
 
        Italics         Underline     Flush Left    Centre   Flush Right   Flush  L&R 
 
        Boldface                                               
 
Font (Type Face) 
 
Margins 
 

 
             Drawing lines and shapes              Wordart                    Scroll Bars 
 
Figure 2:  Example Word window 
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Basic Ideas 
 
This section is revision for most of the class.  A bullet point highlights paragraphs where you 
have to do something.  Even if you think you know the basics, read through the next two-and-
a half pages before coming to the first exercise because there are some hints and tips in the 
text. 
 
There are typically three ways of performing an operation in Word.  You can either: 
1) use a reserved icon on a toolbar.  You can place toolbars at the top, bottom or sides of 

the Word window but the top is the most common place. 
2) use a drop-down menu and select the operation from the list on the chosen menu.  The 

menus are normally accessed from a top toolbar and have names like File, Edit, etc.  
Experience tells you which menu to use in any circumstance. 

3) Use a short-cut key instead of the mouse.  E.g. ctrl-x (control key and x held down 
simultaneously) cuts out selected text, ctrl-c copies text and ctrl-v pastes text, and so on.  
Help - Index - Keyboard shortcuts will get you to the large list of short-cuts available.  
[Commands in italics in these notes, like the ones on the line above, generally indicate 
menu selections to make, or icons to choose or buttons to press; sometimes text to 
enter]. 

 
Word works on the principle that to operate on any text you must select that text first.  This is 
done by moving the mouse pointer to one end of the text, holding down the left-hand mouse 
button and dragging the pointer across the selected text.  Sometimes Word tries to be clever 
and anticipate that you want to select a whole word or whole sentence when in fact you don’t 
want to.  This can be annoying.  Such anticpating action can be turned off from the Tools - 
Options menu but leave doing this until you are familiar with the package.  One way around 
unwanted anticipation by the editor that usually works is to perform the selection backwards. 
 
A second principle worth knowing is that Word will carry forward the format of the previous 
paragraph and apply it to the next one you type. 
 
 
Changing the appearance of the text 
 
 
• The best way to learn how to use Word is to play with it – try out some of the 
formatting options indicated in the previous figure.  In order to do this, type in a few 
sentences and then position the mouse cursor to the immediate left of the first sentence, press 
down the left mouse button and keep it pressed down slide the mouse so that the highlighted 
text is the selection you want.   When you press an icon relevant to the text, all of the 
highlighted text will become modified. 
 
• Try starting with the bold face option – highlight your sentence and then click on the B 
button  and your sentence will change to:- 
 
Try starting with the bold face option – highlight your sentence and then click on the B 
button  and your sentence will change to:-   
 
• Try the italics option.   
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WE DON’T RECOMMEND using the underline option for emphasis.  It is a relic of 
typewriter days when underlining was the only option available for emphasis.  Modern 
documents generally look better without it.  Underlining is used nowadays to highlight active 
web links in a document. 
 
• To the left of the B button is a little number (probably set to 10 or 12).  This number 
controls the ‘point size’ of the text (the unit is written ‘pt’).  Press on the arrow next to the 
number and try clicking on different text sizes, you can  write in very small letters,  or quite large 
letters. 
 
• Now try changing the font (or the type face).  It is probably set on Time New Roman, 
click on the arrow and move down the menu trying out different options. Arial looks a lot 
like a typwriter for example, ALGERIAN IS QUITE ORNATE,  Comic Sans MS is quite 
good for writing party invitations, or Coronet is very pretty and a lot l ike 
some handwrit ing.  One subtlety in Word is that a bullet point takes on the font of the 
end of the paragraph that it marks.  If your bullet point looks funny or is a funny size, then put 
in a space at the end of the paragraph in normal text. 
 
• Now return to Times New Roman 12 pt – take off any bold face, italic and underline 
options and write a paragraph consisting of several sentences.  Remember that this is not a 
typwriter – you don’t need to press carriage return when you come to the end of the line, the 
computer will do it for you.  If you can’t think what to write, copy this paragraph.  Now 
highlight the paragraph and try the flush left option (just to the right of the U button).  You 
will get something looking like this: 
 
This is a flush left paragraph and looks a lot like the text you would get from a typewriter 
because text on successive lines does not end aligned.  The paragraph above is flushed both 
left and right.  An alternative description for the same effect is the printer’s jargon word 
‘justified’.  This paragraph is ‘left justified’; most of the text in these notes is both left and 
right justified, meaning that it starts and ends at fixed points across the page, fractions of a 
space being inserted between words to pad out them out so that the alignment is almost exact. 
 

You can also centre paragraphs using the 
centre button next to the flush left button. 

You will need this for writing titles or 
when writing posters or on any other 
occasion when you want centred text. 

 
Sometimes you may want to use 

the flush right option, for example 
when writing the address in a letter. 

 
 
Lists 
 
In order to write out a list, press the carriage return key to a new line and then click on one of 
the list buttons – there are two, one for numberd lists and one for bullet lists (see Fig. 2). 
 
1. Now every time you want to start a new item use the carraige return key. 
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2. And a new numbered line will appear. 
3. For as many items as you want. 
4. When you are on your last item, press return – a new item number that you don’t want 

will appear. 
 
But by pressing the list button again any list number in the paragraph the cursor is at will 
disapear and you will return to normal text. 
 
Cut and Paste 
 
One of the biggest advantages about using a wordprocessor, as opposed to a handwriting, is 
the ability to move text around to different places.  In order to do this, you must highlight the 
text you want to move or delete and then, using the Edit menu (top left of the window 
between File and View) move down the drop down menu until you come to Cut, click the left 
mouse button and the highlighted text will disappear.  It has not been lost – merely moved 
into memory called the clipboard.  Now move the mouse cursor to where you want the text to 
be moved to and then once again on the Edit menu, click on Paste.  The text will reappear 
from the clipboard – as many times as you want it to.  You can copy diagrams, equations, 
pictures and other objects to the clipboard.  The cut, copy and paste icons can be used instead 
of the drop-down Edit menu. 
 
Margins 
 
Occasionally you will want to alter the margins of your paragraph – for example when you 
write a quote.  Along the top and left of the text screen you will see numbers – like a rule – 
opposite the scroll bars on the bottom and right of the screen.  In the top left-hand corner there 
are two pointers and in the top right one pointer.  You can drag these to alter the postion of 
the text on the screen.   
 
• Try highlighting a small paragraph and adjust these indent bars. 
 

This is a paragraph which could be a quote or 
an abstract or something else that you want 
indented from the rest of the text. 

 
When you have finished, make sure you move the indent bars back. 
 
Exercise 1 for submission 
 
You now know how change the text size, type face, how to make it boldface or italic, how to 
center it, or otherwise change its appearance, make lists and indent text.   
 
• Prepare an A4 poster advertising a lecture to be given on the 22nd of June 2009 at 2 pm 
in lecture theatre 1 of the Fraser Noble Building, given by Prof. your own name, Astronomer 
Royal (author of ‘How to Catch a Star’) on the subject of  “Stars I Want to Introduce to You”. 
If you know how to insert and format pictures into text, then select a suitable feature from the 
web and include it in your poster. If you don’t know how to do this, then see our guidelines 
on page 11 and then attempt it. 
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• Once you have created your poster – save it by clicking File (top left hand corner of the 
window) – move down the list and click on Save As, make sure you are in the directory that 
you want on your H: drive and then where it says File Name, type in the name that you want 
to save the document as there will probably be a default name there already.  In the box below 
this it should say ``Word Document’’ – if it does not, click on the arrow to the right of the box 
and change it until it does.  Print out the poster and hand it in. 
 
Equations 
 
Writing equations in Word is a bit like painting by numbers, a bit tedious and not needing any 
imagination but it will always yield a result.  Some simple equations you can of course 
prepare using the keyboard: y = ax + b for example - you can even get Greek letters simply by 
choosing Insert - Symbol, but for more complicated equations you must use the equation 
editor.  To get at the equation editor, look along the top of the window for the insert option 

(File  Edit  View  Insert …..).  Look down the 
insert menu and toward the bottom you will see 
Object, click on this and a new box will appear.  
Move down the displayed list (figure left) until you 
come to an item that says something like Microsoft 
Equation 3.0.  Click on this item to highlight it and 
then press the OK button at the bottom of the box.  
Two boxes will now appear – one where you will 
assemble the equation and another giving you a list 
of options, shown in the illustration below.  Each of 
the options are menu buttons that display options to 
insert hinted at by the symbols on the button. 
 

Write Equation Here          Symbols         Arrows         Greek letters 

 
 
 
 
Symbol 
Menus 
Box 
 
 
 Brackets     Fractions & sqrt    Powers e.g. x 2      Integrals 
 
• You need to know that spaces are automatically put in where needed - indeed, hitting 
the space bar won’t produce a space (Ctrl - spacebar forces a space).  Try to create the 
following equations with the equation editor and in the process familiarize yourself with the 
options within each symbol menu.  The first row of symbol menus are for inserting special 
symbols such as Greek letters or mathematical symbols. The bottom row are formatting 
templates (e.g. for superscripts, brackets, summations, etc.).  Note the position of the flashing 
cursor, which can be moved through your expression using the arrow keys.  Now type the 
following equations: 
 



PX1512                                                  Computing 2009                     PX1512 

 9

2mcE;maF ==  

3
2

2 a
G

4P)mM(;
dt
dpF π

=+=  

μνμν
π T
c

G8G 4=  

 
When you have finished setting up an equation, click on the screen a little way away from the 
equation box and you will revert to normal text mode.  By clicking on the equation once, you 
can justify it (e.g. centre it) or by formating it as an object you can move it anywhere or give 
it a background colour, etc.  By double clicking on the equation box you can go back to 
editing it.  What you have typed above are some fundamental equations in physics, including 
Newton’s second law of motion (in two forms), Einstein’s energy-mass relationship, 
Newton’s version of Kepler’s second law and Einstein’s field equations of General Relativity 
in a compact notation. 
 
You can put equations on separate lines or incorporate them in a line of text: axy 4= . 
 
 
Tables  

 
Preparing a table is not quite as difficult 
as  doing equations.  Look along the top 
menu (File, Edit, View…… Table) and 
click on Table, look down the drop-
down menu for Insert Table and click 
on this option.  The box shown left will 
appear.  Click on the arrows by the 
Number of columns, Number of rows 
boxes until you have the right number 
of each – then click on the Autoformat 
button (bottom right below the OK and 

Cancel buttons).  The box shown (below right) will now appear.  Try clicking on a few of the 
different formats until you find one that you like – the 
preview screen will show you what they look like.  Try 
experimenting with some of the other buttons as well – 
Font, Shading Color and so on.  Now click on OK in this 
box, then on OK in the other box (above) – the table 

should appear in your 
document.  You can then fill 
in each of the cells with your 
data.  You will probably wish 
to adjust the size of the 

columns, which you will find that you can do with the 
mouse. Double arrows will appear when the mouse 
cursor touches on the cell border lines – by holding the 
left mouse button down you can drag the column or row 
dividing line to where you want it. 
   

A B C X Y 
1 2 3 1 2 
3 2 1 2 4 
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Graphs, Diagrams and Pictures 
 
Graphs 
 
Word has its own graphics package where you can plot data stored in a table.  Highlight the 
data in the table and, as with the equation editor, go in through the Insert – Object menu and 
select Microsoft Graph Chart.  You’re better off drawing graphs on a specialist graphics 
package such as Excel and then importing the graph as a picture. 
 

Figure 4:  This Graph is imported from a graphics package.  It’s a bit small. 
 

Drawings 
 
Drawing simple schematic diagrams can be done quite well and economically in Word.  In 
Word drawings, the individual elements of a drawing are represented as separate objects in 
the code.  The advantage of doing this over a simple bit-map such as is created by the drawing 
package Paint is that Word drawings are scalable to any size without loss of detail.  They 
also generally occupy less filespace than a bitmap picture.   
 
You can draw directly onto a Word manuscript but the better approach is to use Insert - 
Object - Microsoft Word Picture which opens a new window for you.  A box appears saying 
Insert your drawing here.  Ignore it!  Treat the whole page as your canvas.  The box shows 
the area that will be returned by default onto your main page but you can reset the box 
boundaries to fit your own drawing, as described soon.  Now use the drawing toolbar icons 
that appear at the bottom of the screen to assemble the picture from lines, curves, circles, etc. 
and you can add text.  If the drwing toolbar isn’t present, as seems to happen sometimes in the 
class-rooms, then fetch it by using Tools - Customize - Toolbars  and check the drawing box.  
Worth knowing are the following points: 
 
1. You can alter the thickness of lines, their style (e.g. solid or dashed) or whether they 

have arrows at their ends by using the draw buttons at the right of the toolbar. 
2. If you click on the ellipse button, you can force the ellipse to be a circle by holding the 

Shift key down as you expand the cirlce.  Holding both Ctrl - Shift together forces the 
circle to be centred on the cursor position as you expand it.  

3. Holding the shift button while extending a line forces it to be horizontal or vertical, or to 
extend along the line already drawn.  

4. Text boxes should have the ‘No Fill’ option chosen unless you deliberately want a 
background colour and ‘No Line’ unless you want them to have a rectangular box 
around them.  Use the Fill and Line buttons on the draw toolbar. 

5. There is a hidden grid of points covering the drawing and the default settting is to snap 
onto this grid the details of the objects you draw, such as the ends of lines or the centre 
of circles.  It’s best to give yourself the freedom of locating objects anywhere by 
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switching off this snap to grid.  Do this by selecting Draw on the drawing toolbar, then 
Grid to raise the Drawing Grid dialogue box and finally uncheck the snap object to grid 
box. 

 
Notice the little Edit Picture dialogue box that appears with just two buttons on it.  When you 
have finished drawing, click on the Reset Picture Boundaries icon   in this box and then 
on the Close Picture button and the picture will appear on your main page.  On your main 
page, you can control the picture size by clicking on it and using the drag handles to alter its 
shape.  (See a couple of paragraphs on if you aren’t familiar with drag handles).  If you click 
on Format - Object, you can alter its properties, such as allowing the picture to be anywhere 
on the page.  One advantage of creating a separate picture object is that you can move it 
around or copy it easily as a single picture. 
 
Pictures 
 
This section tells you how to incorporate pictures into your document, re-scale a picture, re-
position it and alter the spacing between the picture and the text. Inserting a pre-existing 
picture is easy.  Use Insert - Picture - From File and then browse for the location of your 
picture.   
               
When you have selected your file, click on Insert.  The picture will appear in your document.  
It will probably be the wrong size for what you have in mind.  Click once on the picture to 
highlight it and little squares will appear on the sides and corners called ‘drag handles’.  
Activate a drag handle by centring on it and sliding the mouse with the left-hand mouse 
button depressed.  You will find that you can adjust the size of the figure.   
 
If you wish to wrap text around the figure (so that 
text appears on all sides of the figure) you must do 
the following.  Click on the picture once to 
highlight it, click on Format (between Insert and 
Tools), move down the menu to the bottom and 
click on Picture.  A new dialogue box will appear – 
(see figure right) –select Layout.  Click on one of 
the pictures in each of the rows to select the layout 
style.  We suggest Square.  You can also change 
the clearance between the text and picture using the 
Advanced button.  When you have finished, click 
OK.   You will find that you can move the picture 
almost anywhere you like.  It is a little more 
difficult to insert a figure caption now – you can’t 
simply use center with a smaller letter head – 
instead try using Insert and then Caption. 

 
• Minismise your Word document and open up 
Internet Explorer.  Right click on the picture on the 
University home page and use the Save Picture 
As… option and save this in your filespace as the 
file kings.jpg for future use.  [Today’s web-page 
picture is likely to be different from the one shown 
on the right].  Now maximise your Word document 
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and insert the file kings.jpg where you want it.  By default it is not likely to be the right size or 
in exactly the right place.  Alter the size by clicking and using the drag handles, keeping the 
aspect ratio (the ratio of width to height) the same by moving a corner drag handle along a 
diagonal of the picture rectangle.  Alter the location by using Format - Object (or Picture if 
the object is recognised) - Layout - Square - OK and you can now move the picture about the 
page. 
 
 
Spell Checking 
 
Please make sure the spell checker (nothing to do with Harry Potter) is active when you type 
anything for submission.  Every year we get student work submitted that is spoilt by obvious 
misspelllings that Word could easily have flagged and corrected.   Word also has quite a 
perceptive grammar checker.  As you have been typing you may have noticed that every time 
you mispelled a word a thin red wavy line appeared beneath it.  Sometimes if your grammar 
was a little suspect according to their rules, a thin green wavy line appeared to warn you.  You 
can conduct a full spell check by pressing the ABC icon at the top of the screen (near the 
Insert menu button). 
 
 
Printing and Previewing 
 
Beside the spell checking icon is an icon with a picture of a piece of paper with a magnifying 
glass – clicking this allows you to preview your printed document at various different 
magnifications indicated by the % box at the top of the screen.  You can also preview multiple 
pages at a time using the Multiple Pages icon that appears in print preview next to the % 
selcetion box.  Click on this icon and run your mouse over the little images of pages.  When 
you clock, as many pages as you have selected will appear on the screen.  This is good for 
checking the layout of your report if it has pictures, tables and equations in it.  To get back to 
your normal screen, click on Close.  You can view your document in different layouts by 
using the View menu button and then selecting the view of your choice.  I usually use Print 
Layout. 
 
You can print out documents with the printer icon next to the preview icon – or by going 
through the File menu – File – Print. 
 
 
Concluding Remarks 
 
As you can appreciate, Word can do many, many things.  We haven’t mentioned explicitly 
page numbers (Insert - Page Numbers), putting text in the header and footer regions (View - 
Header and Footer), altering the margins (File - Page Setup), undoing your previous edit(s) 
(use Ctrl - z) and other commonly useful facilities.  You need to explore the menus and use 
the Help menu to expand your knowledge.  However, these notes have covered a good many 
points and with some practice should now be able to produce a high quality document.   
 
As you gain confidence, try exploring the many different pre-made formats that you can find 
in File – New.  These are good for preparing a CV or a newsletter for a society or writing a 

business letter.  Look at Wordart, which you can get at through the icon A at 
the bottom of the screen (see Fig. 2), where you can create effects as shown 
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left, or try compiling an index or a table of contents of your document using  Insert then Index 
and Tables. 
 
Exercise 2 for assessment 
 
Reproduce the following half-page report that includes a number of the features discussed in 
the pages above, namely a diagram, a table, an equation and formatted text.  Include in the 
report your own name.  As well as entering the text, you need to create the diagram, make the 
equation and insert and format the table.  The layout need not be identical to that shown but 
should be a close approximation.  Print off your report and hand it in to the demonstrator 
before you leave, or within the next week. 
 
If you’ve skipped to here without reading all of the earlier text then you can go back and get 
guidance.  We recommend this because there are points in the earlier text you might not know 
about. 
 
The equation editor - page 8 
Inserting tables - page 9 
Drawing diagrams  - page 10 
 
 

Summary Report for PX1512 
 

by own name 
 
The experiment consisted of rolling a 
selection of cylinders various distances down 
an inclined plane so that they fell through 
different heights h.  Each fall was timed.  See 
the adjacent diagram. 
 
 
The plane was set at a fixed angle of tilt of θ 
= 15°.  The time, t, for a cylinder to roll 
down through the height h is expected to 
obey the equation: 
 

2/1

2sin
3

⎥
⎦

⎤
⎢
⎣

⎡
=

θg
ht . 

 
The results are summarised in the table below.  Each time shown is the average of 5 trials at 
the given height. 
 

Material  Height h in mm Time t in s 
Aluminium 300 1.20 
Aluminium 400 1.35 
Aluminium 500 1.59 

Brass 300 1.17 
Brass 500 1.55 

 

h

Start height 

plane 

θ Finish height 
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PX1512 Excel 

Introduction 
Excel is a spreadsheet package.  It allows you to present numerical data in a format suitable 
for inclusion in documents and it also enables you to perform calculations either on data or 
using equations and algorithms.  Some typical examples of where you might use it are: to 
tabulate experimental results, perform calculations on them and plot graphs of results; to 
display numerical results produced by equations; to create balance sheets or accounts, to make 
inventories, and so on.  Excel can be used to draw graphs (including three dimensional 
graphs), histograms, pi-charts and other diagrams.  Automatic processing of Excel commands 
can be programmed. 
 
To access Excel, login to a classroom PC and you should find the Excel 2003 icon on the 
desktop.    Otherwise go to Common Applications - Microsoft Office 2003. 
 
This lab concentrates on three uses of Excel - namely representing results graphically, 
mathematical evaluation, and the data analysis task of finding the best line that goes 
through a set of roughly linear data (this is known as regression).  This exercise assumes a 
basic knowledge of Excel.  In particular, we assume that you know about: 
 

• The appearance and functionality of the Excel window; 
• Referencing cells, e.g. A1, and the difference between A1 and $A$1; 
• Entering equations that involve cell references, e.g. =A1 + B1; 
• Using functions from the Excel library, such as AVERAGE, STANDARD 

DEVIATION, etc.; 
• Copying cell contents and the use of the ‘fill handle’ (the little black square at the 

bottom right of a cell) for row or column copying and filling; 
• Formatting cells, including merging cells and putting borders around cells and groups 

of cells; 
• Saving your work and printing selected areas of a spreadsheet. 

 
Check out this list.  If you’re not sure about any of the items mentioned, ask the demonstrator 
at an appropriate time. 
     
Exercises for assessment 
 
Unlike the preceding Word section of these notes, in this Excel exercise you are expected to 
go through all the examples.  What you hand in is a Word document of a couple of pages with 
some of the plots you have made pasted in.  Organise your work like this: 
 
• Open a new Word document and give it the title Excel Exercise for PX1512 and 

underneath it put by (your own name) and add the date. 
 
• For the first paragraph write the words “Daily temperature fluctuations” and then paste 

in a copy of the graph you have drawn that matches the second one shown on page 17. 
 
• Head the next paragraph “Saturation vapour pressure of water” and paste in a copy of 

your version of the graph on page 18. 
 



PX1512                                                         Computing 2009                                        PX1512 

 15

• Likewise for two further paragraphs headed “Wind chill”, with the graph on page 19, 
and finally “Calibration graph” with the graph on page 21, only with the addition of the 
trendline and equation.  The document should cover 2 pages.  Print it out and hand it to 
the demonstrator, either on the day of the lab or no later than next week’s lab.  No 
submission, no mark. 

 
Plotting Functions 
 
Excel has a wide range of plotting functions and there is no doubt that presenting data visually 
in a report is often more instructive than presenting it in tabular form.  Files for this exercise 
have been made accessible from the class web page.  Copy any files needed into your own file 
space by following this example. 
 
1. Open your web browser (assumed IE) and go to our meteorology home page. 
2. Locate the Computing lab link in the blue box on the left and click on it to take you 

to http://www.abdn.ac.uk/physics/meteo/complab.html.   
3. Put the cursor over the words ‘Aberdeen annual temperatures’ and right click to raise 

the options menu from which you select Save Target As...   
4. You will then get a dialogue box that asks you where in your file space you want to 

put the file abdntemps.xls.  Choose a directory (‘folder’ is an equivalent description) 
to download the file into your own file space. 

5. Minimise the IE browser and go to the directory where you have put your file.  
Finally, click on the file to open it in Excel. 

 
I shouldn’t have said ‘finally’ because that’s the beginning of the exercise, just loading your 
data. 
 
A bar graph 
 
To plot the data you have just 
downloaded as a bar graph, highlight 
the data and choose Insert - Chart - 
Column - Next - Finish and the graph 
appears. You should get something 
like the picture here.  (There may be 
a toolbar icon for Insert - Chart.)  
 
Notice that Excel plots the first row 
along the x-axis and the second 
along the y-axis.  It uses the month 
names as x-axis labels.  This plot is 
not quite good enough for any report of yours.  It lacks a title, the y-axis isn’t labelled, etc.  
Let’s tidy it up.  
 
1. Click on the legend ‘Series 1’ and hit the delete key to get rid of it.  This operation also 

selects the chart. 
2. Click the Chart menu and then Chart Options.  Select the Titles tab and enter a main 

title of Aberdeen Annual Temperatures and a (Y) axis title of Degrees Celsius.  Then 
OK.   
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The Excel philosophy is that if you double click on a part of a chart or graph you will 
raise a context sensitive dialogue box that allows you to edit that bit.  You can now edit 
the titles (e.g. changing their font, or the colour of their text), or the bars, or the background, 
any other part.  The drag handles around the chart allow you to alter its size.  Sliding the 
mouse while holding down the left button with the mouse pointer over the chart moves the 
chart around on your spreadsheet. 
 
3. Try this editing technique by 

double clicking on the white 
area just inside the border.  In 
the dialogue box that appears, 
tick the Round corners box  - 
OK.  I like round corners on 
plots.  Your chart should now be 
like the one shown here.  You 
can pause to look at the 
meteorological information on 
the chart, which is correct. 

 
Notice that when you selected Column as the graph type there were various options available, 
shown by pictures on the right.  The example here is the default option, namely the first one.  
It’s the simplest kind but also the easiest for anyone to use who wants to read the actual 
numbers against the y-axis.  You might choose another option for a ‘glossy brochure’ that was 
intended to convey impact but not be a source of precise numbers.  Try a few of the other 
column options to see what they look like.  It won’t take long. 
 
Scatterplots 
 
The most common way of presenting data in science is to use what just used to be called ‘a 
graph’ but which Excel refers to as a Scatterplot.  This is simply a plot of one quantity against 
another, say y against x, when you are given a selection of pairs of values (x,y).  Excel is often 
introduced in a management and business context where bar-charts, pi-charts, histograms and 
other ways of plotting regular data are shown, but scatterplots are left unexplained.  In any 
science, you need to be confident about drawing scatterplots. 
 
The following exercise will draw a graph like that found in fig. 5.13 of the meteorology 
textbook. 
 
1. Copy the file dailytemps.xls from the computing 

lab web-page, as described above, and open it. 
2. Select columns A, B and C.  Start the chart wizard 

using Insert - Chart and under the Standard Types 
tab select XY (Scatter), then under Chart Sub-type 
select the kind with no data points shown.  The 
reason for this particular selection is that the graph 
is illustrative and there is no significance in the 
particular data values and hence there is no need to 
highlight them with a symbol.  Finish.  You will 
get a graph like the one on the next page.  It needs 
prettying up, as usual. 
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3. a.  Highlight the chart and then 

use the Chart menu - Chart 
Options dialogue box to add 
a title Typical fluctuation of 
daily temperature and 
relative humidity on a calm 
day; an x-axis label of Hour 
and a y-axis label of Temp 
(Celsius) & RH. 

b. Select the chart and stretch 
it vertically a bit 

c. Using the double clicking 
technique mentioned in the 
last section, double click on 
the x-axis scale to raise the 
Format Axis dialogue box 
and select the Scale tab and 
alter the range of values to 
run from 0 to 24 in steps of 6. 

d. Double click on the plotted 
temperature line and raise the 
Format Data Series dialogue 
box.  In the ‘line’ section of 
the box (left-hand side), alter 
the ‘color’ to red and increase 
the width of the line.  OK.  In 
the same way, change the 
relative humidity line to a 
thicker, green line.  Notice that the legend changes line styles in sympathy with your 
changes. 

e. Finally give the outer box round corners and the result should look like the plot 
above.  Copy it and paste into your Word page, as requested. 

 
Excel always chooses the first column in your selection as the default x-axis.  There are at 
several ways around this.  You can order your columns so that the x-axis is the left-most 
column selected, by copying the x-axis data and putting in a new column on the left if 
necessary.  This sounds a bit cumbersome but is a quick option.  Alternatively, after you have 
selected the chart type (scatterplot), at step 2 of the chart wizard click on the Series tab and 
edit the x-axis and y-axis ranges selected for each column plotted.  If you have already plotted 
the graph wrongly, then select the chart, click on the Chart icon on the toolbar and select 
Source Data, which gives you the Source Data dialogue box.  Now select the Series tab, 
whereupon you will be able to edit the data used for the x and y directions at will, as just 
described. 
 
Plotting a calculated curve 
 
Suppose you need to know the saturation vapour pressure of water but haven’t got access to 
any values.  However, you remember the facts that at 0°C the value is 6 mbar and the pressure 
approximately doubles every 10 K.  These 2 facts tell you that you can represent the required 
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pressure P by the relationship P = 6×2T/10.  This is enough to let you calculate the saturation 
vapour pressure over a range of temperatures.  Let’s choose -20°C to 40°C. 
 
• Open Excel and head columns A and B with the words 

“temp” and “pressure”.  Put the values –20 in cell A2 
and –18 in cell A3.  Highlight cells A2 and A3 and put 
your cursor on the fill handle in the lower right of the 
highlighted rectangle.  Now drag the fill handle down 
and it will automatically fill in column A for as long as 
you go with values increasing by 2 degrees in each cell.  
Stop at 40°C. 

• Set cell B2 as “=6*2^(A2/10)”.  Don’t put the quotes in, 
just the rest.  Notice the use of the carat key (shift 6) to 
represent powers in Excel.  Now highlight cell B2 and 
use the drag handle to run the formula down all the rows 
that have temperatures.  The start of the spreadsheet 
should now look like the picture on the right. 

• You now have pairs of points in columns A and B that 
you want to graph (i.e. make a 
scatterplot).  Use the same 
method as in the previous 
example to produce a properly 
labelled graph, like the one 
shown on the right.  In 
particular, this graph has a 
caption and labels on the axes 
in 12 pt Times New Roman.  
The line thickness and 
background colour has been 
altered, as has the aspect ratio 
(the ratio of height to width).  
The background has been set to 
light yellow in my version, 
which contrasts well with blue 
diamonds but these colours 
don’t show in a black & white copy. 

 
Two Dimensional Functions 
 
It’s quite common to want to know how something varies when it depends on two separate 
quantities.  The example we’re going to look at is ‘wind chill’.  Wind chill is the temperature 
that you feel on your skin when there is a wind blowing.  It depends on the air temperature, T, 
and the wind speed, v.  I’ve looked up an expression that will let us calculate the wind chill 
temperature, call it W, given the two factors T and v.  The expression works for a reasonable 
range of temperatures and wind speeds equal to or greater than 2 m s-1.  It is: 
 

W = 13.129 + 0.6215T – (13.947 – 0.486T)v0.16 
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We’re going to generate a table of the wind chill from -20°C to +10°C for wind speeds from 2 
to 40 m s-1. 
 
• Open a new Excel sheet.  Enter T/v in cell A1 as a heading to indicate that increasing 

temperatures are going to be along a row and increasing wind speeds down a column.  
This will be clear when you look at a section of the spreadsheet shown below. 

 

 
 

• Now enter the range of wind speeds down column A by putting the value 2 in A2, 4 in 
A3, selecting both A2 and A3 and using the fill handle to complete the column up to 
A21 which should have the value 40 in it.  Repeat the process for row 1, starting with 
the value –20 in B1, -18 in C1 and using the selection and drag handle to fill the row up 
until Q1, which should have the value 10. 

• Fortunately you will only have to type the formula above into one cell.  In cell B2 type 
=13.129 + 0.6215*B$1-(13.947-0.486*B$1)*$A2^0.16 .  Notice the use of the $ 
symbol.  This will prevent the running index after the $ from changing when you drag 
the formula across the other cells and 
ensure that all the entries in a given 
column refer to the same temperature 
(that’s the $1 at work) and all the 
entries in a given row refer to the 
same speed (the $A at work).   

• Now get hold of the fill handle for B2 
and drag it down to cell B21, filling 
in the first column.  Grab the handle 
again with B2 to B21 selected and 
slide it across to column Q to 
complete the table.  The top left of 
the table is reproduced here.  Use the 
centre justify button to centre the 
entries for the whole table and the 
decimal place adjust button to reduce 
the number of decimal places 
to 1, which is all the formula 
merits. 
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Now we will use the scatterplot again to make a plot of wind chill verses wind speed for a 
thermometer temperature of 0°C.  The extra point here is that the two columns you want to 
plot aren’t adjacent.  Select the data in cells A2 to A21.  Now hold down the ctrl key and 
select the data in cells L2 to L21.  You have successfully selected data to plot in non-adjacent 
columns.  Now use your scatterplot skill to make a graph like the one shown on the previous 
page.  The diagram has been reduced in size but note that the words are in Times New 
Roman, the font size 12 pt for the axes labels and 14 point for the title.  The curve has been 
thickened, the vertical height stretched and the default background lightened (to pale yellow).  
The axes ranges have been tidied up and the wind speed labelling has been moved from its 
default at the y value of zero to the y value of –12.  This last operation is done from the y axis 
dialogue box. 
 
Data Analysis 
 
In order to use the Data Analysis software you may find that you first need to click on the 
Tools menu - go down and select Add-Ins then select Analysis Toolpak.  The whole procedure 
takes about 30 seconds to install the software - so be patient.  After this, in order to use one of 
the Data Analysis tools once you have selected some data, simply click on Tools and select 
Data analysis.  If you click on Tools without any data selected, then the Data Analysis option 
may not appear. 
 
There are many data analysis tools in Excel.  We shall look at two. 
  
Regression Analysis 
 
Regression is what you do when you find the best smooth curve to represent a set of points 
that are dotted around a bit.  This fitting means taking a function that has constants in it and 
finding the best values for the constants so that the resulting function runs through the points 
in a way that ‘best fits’ the data.  The most common kind of regression is called linear 
regression in which the constants just appear linearly.  Thus in the expression y = ax2 + bx + 
c that might represent a curve through a set of points, the value of y depends linearly on a, b 
and c, the unknown constants, and hence linear regression is what you need to determine the 
appropriate values of a, b and c. 
 
Excel has limited but useful regression facilities.  It can fit polynomials through data and in 
particular a straight line through a set of points, the line being represented by y = ax + b.  In 
Excel jargon, this line is called a trendline.  This section of the notes shows two ways of 
finding the trendline.  The first very simple way can write the trendline equation on your 
graph.  The second way gives you more detailed statistics associated with the trendline.  First 
we need some data. 
 
• Open the file calib.xls that is with the other files on the web page as described earlier.  

This file contains the results of calibrating an electronic thermometer against a ‘gold 
standard’ thermometer that was the best available at the time.  The first column 
represents temperature readings (from the thermometer) and the second the voltage 
output of the electronic thermometer recorded on a voltmeter that read to mV.  The task 
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is to find the best straight line that represents this data and the uncertainties in the 
parameters of that line. 

 
• Now make a scatterplot of the data, which 

should look like the picture here. 
 
• To find the trendline, first click on a data 

point on the graph.  On the Chart menu 
select Add Trendline and this will throw 
up the Add Trendline dialogue box.  In 
this box under the Type tab select Linear 
and then click on the Options tab and tick 
Display equation on chart.  Finally, click 
on OK.  The equation should now appear 
and the trendline should be drawn in.  The 
top right hand section of the graph should now look like the 
image shown on the right here.  You can see that the line fits the 
data quite well and it has the equation y = 0.0395x + 1.0163.  In 
our context, the y values are voltage outputs and the x values the 
temperatures.  The slope of the graph gives the sensitivity of the 
electronic thermometer, namely 0.0395 volts per degree.  You 
can move the equation about on the graph. 

 
The advantage of using a computer to calculate the 
regression equation is that you can get a whole lot 
more statistics at the same time that may let you 
extract more information from your data.  This fuller 
information is found by using the Data Analysis 
pack explicitly to make the regression.  Highlight a 
cell on the spreadsheet and under the Tools menu 
select Data Analysis to raise the menu shown here.  
Select Regression.  You now get the quite complicated Regression dialogue box.  This is how 
I fill it in. 
 
• Click the Input Y range box to make sure 

the cursor is flashing there.  Now select 
the y values on your spreadsheet, namely 
B2 to B22 in this exercise.  When you 
release the mouse button the range will be 
transferred into the box.  Similarly, click 
on the Input X range box and then select 
the x data running from A2 to A22. 

• For the Output options select Output 
Range, click on the white box to the right 
and then on a cell where you’d like the 
regression output to start.  I have chosen 
D25 

• Finally, select Residuals, Residual Plots 
and Line Fit Plots to produce three optional pieces of supplementary output. 
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You now get 3 tables of output and two graphs for your money.  Lets look briefly at all this.  
The first table is headed SUMMARY OUTPUT.   You can ignore this.   
 
The next table is headed 
ANOVA, which is statistical 
jargon for ‘analysis of 
variance’.  There is some 
useful information here.  The 
second sub-table of information starts Coefficients, etc., as in the illustration above.  I would 
personally tidy up the table if I were going to keep it by reducing the number of decimal 
places shown and centring the information in the cells, but that’s a personal preference.  More 
importantly, the Standard Error column shows the random errors in the two parameters you 
have found in the regression, worked out on the assumption that the deviations of your data 
from the line represent the random errors in your data.  Hence the calibration figure of 0.0395 
volts per degree is known to ±0.0004.  The constant 1.0163 is known to ±0.0096, which is 
effectively ±0.01.  For the statistically knowledgeable, these ± values are 1 standard error or, 
if you like, one standard deviation in the distribution of the constants.  The next column 
showing the t Stat is the reciprocal of the fractional accuracy with which you know the 
constants.  100/(t Stat value) gives you the % accuracy.  Thus 100/96 (≈1%) tells you that the 
figure of 0.0395 for the calibration constant is known to 1%.  The next column tells you the 
probability that the values you have found differ from zero just due to random sampling.  The 
probabilities are negligible in this example but sometimes they can tell you that an intercept 
or slope you have a number for isn’t really significantly different from zero. 
 
The RESIDUAL OUTPUT table lists the y values given by the trendline for the given x 
values and also the difference between each of these values and your initial data values.  
These differences are called the Residuals.  This may be useful information.  You can see 
looking down the residuals that the 9th observation differs much more from the trendline than 
any other point.  You can see this even more easily by looking at the graphs.  One shows the 
plot of the residuals against the x values.  The residuals aren’t quite spread around at random 
as much as you might expect so you might be tempted in real life to look and see if your 
calibration had some systematic defects in the procedure.  The second plot shows the given 
data and the predicted values from the trendline.  You already have this from the trendline 
exercise above but you could alternatively get the same graph by knocking this one into 
shape.  The labelling of these graphs needs 
improving, they need stretching and the scales 
need tweaking if you were going to keep 
them. 
 
Being able to find the regression statistics is 
very useful and if you are analysing data ‘for 
real’ in future, remember to do this. 
 
Descriptive Statistics Function 
 
This is a useful little function.  It allows you 
to determine quickly a deal of information 
about a series of numbers - values like the 
mean, the standard deviation, the median, the 
mode, etc.  
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We’ll try this on the figures in column D of the calibration spreadsheet (which are actually the 
residuals from the previous fitting exercise).  Once again, go into the Tools menu, select Data 
Analysis and then select Descriptive Statistics.  Choose the input range by clicking on the 
Input Range box and then highlighting the data (in this case the D2 to D22).  Select Output 
Range and then click on the white box to the right and then a spreadsheet cell where you want 
the results to start appearing.  Tick Summary statistics and Confidence Level for Mean and, 
finally, OK.  You will then get the descriptive statistics shown below. 
 
You can see that the mean is zero, which is one of the 
criteria for the ‘best fit’ regression line.  The standard 
deviation tells you that on average the measured voltages 
differ from the trendline by 22 mV.  The skewness term 
suggests that the residual distribution is leaning towards 
negative values and the kurtosis that it is not a normal 
distribution.  However, all this gets us into statistical 
interpretation, which isn’t part of the lab. 
 
 
Conclusion 
 
You should now be pretty good at basic scatterplots.  It is 
easy to plot more than one quantity on a graph, if need be.  
Regression is a very useful tool to know about and one 
that is often used to find a trend in data that is much more spread around than our calibration 
line, which is an example of ‘very good’ data that lies tightly around a line. 
 
 
JSR 
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Astronomy Assessed Assignment 
 

Letter from Afar 
 
Imagine yourself living on another planet or moon in our solar system in the year 2109.  
Assume that you live in environmentally protected quarters but from time to time have to 
venture outside on missions.  Write a 1-page letter home (Dear...) describing life as you find 
it. 
 
You should look up the textbook or web pages to find the physical conditions at your chosen 
base, such as gravity, temperature, atmosphere (if any), nature of the surface, distance from 
the Sun and so on.  Make notes.  Locate the names of some real places, if your planet or moon 
has been named.    Look for further details of your location on the web, using as a start our 
astronomy course links page or sites of your own choice. (Our page: 
http://www.abdn.ac.uk/physics/astro/astlinks.html).   
 
Here are some issues you can address.  There won’t be room to cover them all. 
 

• What are you there for? (everyone should say something about this) 
• What is your job in the team? (ditto)  
• Who went with you or is living with you? 
• How are you coping with the problem of staying with the same people all the time in 

cramped conditions? 
• What is your food source? 
• How is water obtained? 
• What do you do in your free time? 
• Is there any entertainment? 
• What do you miss most from home? 
• How is electricity generated? 
• How much natural light is there? 
• How are you protected from the local conditions of temperature, pressure (or near 

vacuum) and composition of any atmosphere?  
• How do you get around? 
• What effect does reduced gravity have? 
• What protection have you from the Sun’s UV and high energy solar particles? 
• For long-term missions, how is sustainability maintained or planned for? 

 
Send your letter via e-mail as a Word attachment in .doc format to homebase, aka 
p.bonifacio@abdn..ac.uk with the words ‘letter from afar’ as the e-mail subject.  Length: 1 A4 
page, 12 pt Times New Roman (interplanetary e-mails are expensive!).  Include your full 
name somewhere on the document.   Assessment will be based on the factual accuracy of 
what you say about your site (judged against today’s knowledge!), the plausibility of your 
reason for being there and the imaginative content of your letter.  Remember that there are 
serious survival problems everywhere in the solar system except on Earth - too hot, too cold, 
no atmosphere, no water, no indigenous food, etc.  The final two computing session have been 
reserved for this activity so you can be sure of a reserved seat at a terminal and scheduled 
time to do it.  That will give you four hours, which should be plenty.  You can do this exercise 
outside the classroom if you prefer.  Everyone is recommended to obtain confirmation that 
your message has been received and read for this and any other exercise sent as class-work 
by e-mail.  Most other mailers have an equivalent function. 
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At the first session you should at least choose a place and make notes about conditions there, 
thinking about what you might tell your recipient.  You should aim to e-mail the letter by 
the end of the final session, although the absolute deadline isn’t until a week later.  Are 
you seeing red over your mission, having a jovial time or a titanic struggle?  I may put the 
best ones on a page on the web, linked from the astronomy homepage. 
 
Footnote: If you plan to be at one of the ‘gas giants’ then you can’t land on a solid 
surface and you can’t gravitationally orbit the planet within the atmosphere.  The reason is 
that the orbital speed at the distance of the outer atmosphere is much greater than the 
rotational speed of the atmosphere and hence atmospheric drag would slow you down, heat 
you up and gravity would pull you inwards, trying to speed you up as it did so.  The result: 
cinders floating in the atmosphere.  This is the same reason why Earth satellites must orbit 
outside our atmosphere.  You can find out more about how satellites and orbits work in our 
level 2 Space Science and Remote Sensing course.  What you can do at the gas giants is float 
in their atmosphere if the density of your capsule, bubble, module or whatever is made equal 
to the density of the atmosphere outside.  Then you will just circulate around the planet with 
the atmosphere around you, like a balloon.  Alternatively, you can land on one of the many 
moons of the gas giants. 

 
JSR 

 


